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Gallery

Here you can see a typical use of each filter in Snap
Art. This can help you find the filter that matches the
style you are looking for.

Color Pencil

Oil Paint

Pastel Pen and Ink Pencil Sketch

Pointillism Stylize Watercolor



Welcome

Thank you for purchasing Snap Art from Alien Skin Software. Snap Art will help you to quickly
create natural media artwork from a photograph. To get started, just open the image in your
image editor (usually Photoshop), start one of the ten filters from Snap Art under the Filter
menu, and choose a preset. To help you decide which filter to run, here is a quick overview of
the choices. You can click on a filter name to jump to that chapter.

Color Pencil

Create a highly detailed, hand-drawn sketch from your photo. This filter creates detailed
portraits as well as landscape art. This filter is one of the most popular for traditional tasteful
portraits.

Comics

Create a comic strip look with stylized colors, halftoning and different shading patterns. This is a
funky modern look, unlike more traditional styles.

Impasto

Impasto is a technique in which the artist applies a thick coat of paint on the canvas to produce
an abstract textured surface. It produces a rougher 3-D look than traditional oil painting but can
be used for portraits or abstract landscapes.

Oil Paint

Create a traditional oil painting such as an intimate studio portrait or a painterly landscape. This
filter is one of the most popular for traditional tasteful portraits.

Pastel

The pastel filter will help you create soft portraits or abstract landscapes. It differs from an oil
painting because the pastel medium is not as dense or detailed as a paint brush.

Pen and Ink

Create a black and white pen drawing from your photo. This filter creates a stylized look and
works best with simple images with large features. Typically this filter is not used for portraits.
The color conversion sliders in the Tone Tab have a big effect on this filter.

Pencil Sketch

This filter creates a monochromatic (grayscale) rendering. You have enough control to make an
abstract sketch or a detailed portrait. The color conversion sliders in the Tone Tab have a big
effect on this filter.



Pointillism

Create an impressionist painting resembling the classic technique of using short brush strokes.
This filter is best for colorful outdoor scenes.

Stylize
Create a modern, Pop Art look with simplified colors and smooth lines on the edges of the
image. This is a funky modern look, unlike more traditional styles.

Watercolor

This filter can be used to create soft portraits or abstract landscape scenes. This filter is best for
landscapes. Portraits will have less detail in Watercolor than in Qil Paint.

INSTALLATION (SAME FOR BOTH MACINTOSH AND WINDOWS)
Shut down your graphics host program (usually Photoshop).

Run the installer found on the CD or that you downloaded.

You may be asked to enter the username and password of an account with administrator
privileges. If you don’t have administrator privileges, talk to your IT gal or consult your Mac 0S
or Windows manual.

After the license agreement screen, you will see a list of compatible graphics programs on your
computer. Choose one and click OK. If you want to install into another graphics program, run
the installer again.

ACTIVATION

Snap Art 2 has an activation system that works just like the one in Photoshop. Until Snap Art 2
is activated, periodically it will ask you to activate. Activation is a very quick and easy process in
which Snap Art 2 lets our activation server know that your license code is in use. This only
needs to be done once. Snap Art 2 does not talk to our activation server again after it has been
activated. No personal information is sent other than the license code.

You can use Snap Art 2 for up to 30 days without activating. After that, Snap Art 2 will stop
working until you activate it.

You can have Snap Art 2 activated on up to two computers at once, so you can have it on both
your laptop and desktop computers. If you ever get rid of your computer, don’t forget to
deactivate Snap Art 2 first! You can do that by going to the menu entry Help>Deactivate.
Then you can activate Snap Art 2 on a new computer.



OTHER SOURCES OF HELP

This manual is just one of many sources of help for Snap Art. Once you start Snap Art, check

out the Help menu for links to lots of helpful parts of our web site, including video tutorials

and the Snap Art Forum. The video tutorial on getting started is a great one to watch before
you run Snap Art for the first time.

WHAT’S NEW

Performance.

Under the hood, the Snap Art rendering engine has changed significantly. You will notice that
the filters are much faster and can run on much larger images than before.

More control.

New focus regions have been introduced to the user interface. Focus regions will let you add
more detail where you need it such as faces or the subject of your artwork. The controls for the
focus regions are at the top of the user interface above the settings.

Settings.

Settings have been reorganized and now have categories. Start by choosing a category and
then a brush size. Then there will be multiple options for a variety of effects. If you need highly
detailed control, switch to one of the tabs to the right of the Settings Tab for access to many
details of the rendering process.



http://www.alienskin.com/snapart/snapart-tutorials.aspx
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User Interface Overview

The next few sections explain every control in the Snap Art user interface. Screen shots are
randomly from a Macintosh or Windows computer, whichever was handy at the time. All the
gizmos are in the same places and behave the same way on both platforms. They are just more
shiny on the Mac.

Below is a screen shot of the Snap Art user interface with the Settings Tab selected.
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A: TITLE BAR
The title bar displays the currently selected setting (see the Settings Tab chapter).

B: FOCUS REGION CONTROLS

The controls in the upper left of the window let you create focus regions that make part of your
artwork sharper. When focus regions exist, they are drawn as ovals on top of the preview. For
details, see the chapter Working with Focus Regions.

C: NAVIGATION THUMBNAIL
Click and drag the movable red box to quickly move the preview around your image.



D: PREVIEW TOOLS (ONLY ONE AT A TIME IS ACTIVE)

Click and hold the Show Original Button to see the unmodified form of the image.
=51 An easier way to do this is to simply hold down the Spacebar.

Click the hand to enable the Move Tool. Then click and drag in the preview to move
around the image.

Click the magnifying glass to enable the Zoom Tool. Then you can click in the preview

window to zoom in. Option-+click (Macintosh) or Alt+click (Windows) to zoom out.
Double-clicking the magnifying glass resets the preview window to 100% magnification. While
in zoom mode, holding down the Spacebar temporarily switches to the Move Tool. Many of the
same shortcut keys that Photoshop uses to navigate a preview window work in Snap Art too.
Click the circle to enable the Adjustment Tool. While this tool is active, you can

manipulate the focus regions overlaid on the preview. For more information on focus
regions, see the chapter Working with Focus Regions.

E: PREVIEW SIZE BUTTONS

|1 [ R |

Click the 1:1 button to quickly view the actual pixels of the image unzoomed.

Click the Fit button to fit the preview in the current window.

F: SPLIT SCREEN PREVIEW

Above the preview area is a menu of options for split screen previewing. When enabled, this
feature shows the original image in half of the preview. The entries in the Split Screen menu
specify the orientation of the split line or simply turn it off.

G: UPTODATE MESSAGE INDICATOR

When you see this visual cue, you have a new message from Alien Skin Software. Click here to
open a web page containing the message. UpToDate messages are usually announcements of
updates, new products, or our monthly newsletter. You can set the frequency that UpToDate
checks for messages or turn it completely off in the Preferences dialog.

H: OK AND GANCEL

Clicking the OK button applies the filter with the current settings. Clicking Cancel closes the
filter window without applying the effect. The Enter key is the same as clicking OK and Escape
is the same as clicking Cancel.

I: TABS
The Settings Tab lets you quickly select a preset or one of your saved custom settings. Click



any of the other tabs (Basic, Colors, Canvas or Lighting) to open up the detailed controls for
each Filter. Each tab is described in detail in later chapters.

J: PREVIEW AREA

Preview the effect on your image here. Resize the filter window to make the preview area larger
or smaller.

K: FOCUS REGION

You can control the detail of rendering by manipulating focus regions. For more information on
focus regions, see the chapter Working with Focus Regions.

L: TOOLTIP HELP

Whenever you move your cursor over a user interface element, a short description appears as a
tool tip.

M: PROGRESS BAR AND MAGNIFICATION INDICATOR

While the preview is being drawn, a progress bar is drawn to the left of the magnification
indicator. The magnification indicator shows the current zoom level of the preview.

MENUS

Command menus are accessible when you launch Snap Art. Macintosh users will see the
menus in place of their usual menu bar. Windows users will see the menus at the top of the
plug-in window.

Edit Menu

The Edit menu provides an unlimited ability to undo or redo changes. If you experiment with the
sliders and find that you prefer a previous group of settings, select the Undo command from the
Edit menu or click Command+Z (Control+Z on Windows) to back up as many times as
necessary. The Edit menu also lets you copy, cut, and paste values from parameter fields.

View Menu

The View menu lets you zoom the preview in and out. To display the entire image in the preview
window, select Fit On Screen. To display the preview at 100% magnification, select Actual
Pixels. See Keyboard Shortcuts for some nifty zooming shortcuts.

Help Menu

From the Help menu you can read the PDF manual (this document). The same assistance can
be reached by pressing F1 (Windows) or Help (Macintosh).

There are Help menu entries that go to the following places on our Web site:
o Video Tutorials


http://www.alienskin.com/snapart/snapart-tutorials.aspx

e Snap Art Product Web Page

e Alien Skin Software’s Home Page
¢ Online Forums

e Support Knowledgebase

e UpToDate Messages

From the Help menu you can Activate or Deactivate the locally installed copy of Snap Art. See
the Activation section earlier in this document for more information.

Preferences

After starting one of the Snap Art filters, select Edit>Preferences (Windows) or
Photoshop>Preferences (Macintosh) to modify preferences. You can also get there by typing
Command+K (Macintosh) or Control+K (Windows).

UPTODATE

Here you can set the frequency at which the UpToDate system checks for messages from Alien
Skin Software. The UpToDate system informs you about the latest Alien Skin Software products,
special offers, software updates and other news. When a new message is ready, a button will
appear at the top of the user interface labeled “Click here for new messages from Alien Skin”.

PREVIEW BACKGROUND

If you use layers with transparency, you can set the color or pattern that is drawn to represent
transparent pixels in the preview.

FAVOR MEMORY OR SPEED

If Snap Art runs out of memory, try moving this slider toward the Memory side. Then restart
Photoshop and you may find that the problem goes away. If you are using images over 4
megapixels, then you may get a mild speed boost by moving the slider toward the Speed side.

DISABLE OUTPUT ON NEW LAYER

Most of the time, the capability to render Snap Art’s output to a new layer is handy. This can be
done by turning on the checkbox on the Basic Tab named “Create Output In New Layer Above
Current”. However, that feature is not compatible with Photoshop Smart Objects. If you use
Photoshop Smart Objects, it is useful to turn this feature off in the Preferences dialog.
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KEYBOARD SHORTCUTS

SHORTCUT FUNCTION MACINTOSH WINDOWS
Navigate to Next Control Tab Tab
Navigate to Previous Control Shift+Tab Shift+Tab
0K Return Enter
Cancel Escape Escape
Undo 8+7 Ctrl+Z
Redo #B+Y Ctrl+Y
Cut 8+X Ctrl+X
Copy 8+C Ctrl+C
Paste 8+V Ctrl+V
Zoom In 8++ Ctrl++
Zoom Out 8+- Ctrl+ -
Actual Pixels Option+88+Zero Alt+Ctrl+Zero
Fit on Screen 88+Zero Ctrl+Zero
Load Factory Default Setting 8+R F5

Load Last Used Setting 8+L Ctrl+L
Save Setting 8+S Ctrl+S
Switch to Move Tool (hand) H H

Switch to Zoom Tool VA VA

Switch to Adjustment Tool A A

Preview Move (with zoom enabled)

Space Bar+Drag

Space Bar+Drag

Zoom In (with zoom enabled)

Mouse Click

Left Mouse Click

Zoom In (with move enabled)

38-+Click

Ctrl+Click

Zoom Out

Option + Mouse Click

Alt + Mouse Click

Drag preview (with zoom enabled)
— also displays original image

Hold spacebar while dragging

Hold spacebar while dragging

Zoom to Actual Pixels

Double-click Zoom Tool

Double-click Zoom Tool

Increase/Decrease Slider by 1 Up/Down Arrow Up/Down Arrow
Increase/Decrease Slider by 10 Shift+Up/Down Arrow Shift+Up/Down Arrow
Next Filter 8+ Ctrl+]

Previous Filter 8+ Ctrl+[

Open Manual 38-+/ or Help F1

Open Preferences Dialog 8+K Ctrl+K



Settings Tab

Settings | Basic | Colors | Canvas | Lighting |

Factory Settings

-] Factory Default

--ﬁ “Favorites

[#-45 Abstract Jow realism)

--{:;i Landscape {moderate realism)
--ﬁ Portrait {most realism)

-3 Vignette and Canvas

User Settings

38 § Favorite Abstract Settings
(-3 Favorte Portrait Settings

The Settings Tab lets you create, manage, and share your favorite settings. There are two lists
on the Settings Tab. The top list contains factory settings. Factory settings are supplied with the
product and can’t be changed. The bottom list contains user settings, which are settings you
can create yourself.

LOADING SETTINGS

Simply click on a setting to move all the controls to the values saved in that setting. The only
controls that are not loaded from a setting are the Focus Controls in the upper left of the
window. We did that because you generally don’t want your focus regions to move just because
you are switching brush size.

SAVING SETTINGS
To save a setting, first adjust the sliders and other filter controls to your satisfaction. Then, click



the Save Button at the bottom of the Settings Tab. You can also save a setting by pressing
Command+S (Macintosh) or Control+S (Windows). The Save Setting dialog box will appear.
There you can specify the name and category of the new setting.

MODIFYING SETTINGS

To modify the control values in a setting, move the controls and then save the setting with the
same name. This is easy because the Save Settings dialog is always filled out with the most
recently loaded setting name.

You can also right-click (Windows) or Control-click (Macintosh) on a setting to rename, delete,
export, or e-mail it.




Working with Focus Regions

Edit Filter View Help
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Focus regions allow you to add photographic details back into the image so important features
in your photograph such as faces are rendered with more detail. You can add, delete or modify
the strength of the regions from the “Focus Control” area above the settings. Each region is an
oval drawn over the preview. You can grab a focus region to move and reshape it. You can only
manipulate the focus regions when the Adjustment Tool is active 2] . When you are in a
different tool mode (e.g. the move or zoom tool), the focus regions will appear as dashed lines
and cannot be manipulated.

Each focus region has a strength associated with it. If you set the strength low (in the 1-20
range), you will find that you can add important detail back into your image and it will blend
naturally with the rest of the image. If you set the strength high (near 100) you can make that
region look dramatically different than the rest of the image and is usually not a good idea.
You can make the entire image more detailed if you boost Photorealism and lower Brush Size
on the Basic Tab.



FOCUS CONTROLS
The controls above the settings tab let you create, delete and modify focus regions.

Selection Strength.

The selection strength slider is visible when you have made a selection in Photoshop (or
another host application) prior to running Snap Art. Selection strength adds extra detail to just
the selected area in the same way that focus regions add detail. When you make a selection
before running a filter you do not need to feather your selection as the filter will do this
automatically for you. You will usually get good results if you use the lasso tool to make a rough
selection but any other selection technique will work. Note that a selection can be used only if
Snap Art is not run as a Smart Filter.

Add New Focus Region.

Clicking this button will add a new focus region to the image, centered in your preview window.
See below for more details on how to control individual focus regions.

Delete Current Region.
Clicking this button will delete the currently selected focus region.

Focus Strength for Current Region.

The focus strength slider will affect the strength of the currently selected region. You can set
the strength independently for each focus region. Low strength will add subtle detail to the
image while strength of 100% will make that region look almost like the original image. We
recommend that you set it in the 5-25 range for a more natural look.

Reset to Default Focus.

Clicking this button will remove all focus regions except a single region centered in the preview
window. It can be useful when you want to start over.

Hide Focus Outlines.

Selecting this checkbox will hide the outlines of the focus regions in the preview window. The
effects of the regions will be rendered but the distracting outlines will be hidden. When this
checkbox is enabled, the other controls related to the focus regions will be disabled.




MANIPULATING THE FOCUS REGIONS
If there are not any focus regions, add one by clicking the Add New Focus Region button and
make sure you have selected the Adjustment Tool G .

Dpﬁ'l Preview Split: . -

l)" ( 418
In the preview window, the focus region outlines will let you control the shape of the focus
regions.
Click and drag in any area within the dashed line to reposition the region.

Click a region’s color handle to make it the currently selected region. This
works even if it lies behind another focus region. If you drag the handle, it will
resize the region.

Drag the dashed oval to change the feathering amount.



Control Tabs
(Basic, Colors, Canvas, and Lighting)

In order to take your artwork to the ultimate level of customization, you can go beyond the Settings
Tab to fine-tune the effect. This is done in the Basic, Colors, Canvas, and Lighting tabs.

BASIC TAB

|SetLi.ng3| Basic |Cc|ors ICanvasI Lighti.rlg|
[¥]Create Output In New Layer Above Cumenti
Brush Style: | Defautt Bush ~|
Brush Size O ,20_ %I
Phot lism Amourt |

orealism Amou G IG'D—ZI
Paint Thickness W %II
Paint Stroke Length - ,5,0_ %II
b

o

The Basic Tab controls the most important aspects of your artwork such as the placement of
brush strokes and the size of the brush. Please see the documentation for each individual filter
for the details since each filter varies.

The one control that all filters have in the Basic Tab is the new layer checkbox.

Create Output In New Layer Above Current

Applying a filter with this option enabled renders your image in a new layer above the working
layer (in Photoshop and Elements only). There are some caveats to this feature.

Switching filters within Snap Art disables this feature. If you want to apply a filter in a new layer,
make sure you start with the filter you plan to apply.

An action recorded with this option enabled will not create an additional layer. If you are
recording an action and want your result in a new layer, you must create the layer before you
run the Snap Art filter.

This feature is not compatible with Photoshop’s Smart Objects. If you are using Smart Objects, you
really don’t need this feature anyway because the filter becomes nondestructive. When using
Smart Objects, turn this checkbox off or turn this feature off in Snap Art’s preferences dialog.



COLORS TAB

The content of the Colors Tab will vary by filter. Please see the documentation for each
individual filter for the details since each filter varies.

CANVAS TAB
| Settings | Basic | Colors | Canvas | Lighting |
Canvas Texture: [F‘aper, thick drawing paper ']
Canvas Thickness O il ﬂ
Canvas Zoom 0 ﬂ
U
Canvas Calor I:‘
= \ignette
Opacity (%) =
Size (%) ] 0 =
Feather (%) o =
Distortion Amount (%) 0 %II
U

The Canvas Tab lets you control the type of canvas or paper that your artwork is displayed on as
well as vignette. The vignette causes the image to fade out on the outer boundary as an
elliptical shape. As the image fades out, the canvas will be revealed.

Another way to affect the image fade out is to erase pixels before running the filter. Pixels with

zero opacity will result in the canvas showing through, much like the vignetting effect. You can

use the eraser tool in Photoshop to erase the parts of the image around the boundary to get an
artistic vignetting effect.

Canvas Controls

Canvas Texture
Choose from a variety of canvas or paper textures.

Canvas Thickness
Higher thickness will make lighting on the canvas texture more noticeable.

Canvas Zoom
When you increase the zoom level, the ridges in the canvas are spaced wider apart.



Canvas Color/Tint
Choose any color for the canvas. For the Pen and Ink and Pencil Sketch filters, the canvas color
will be tinted so you cannot achieve a fully black color.

Vignette Controls

Opacity

Controls the intensity of the vignette. At 0%, no vignette is applied. At 100%, some pixels will be
completely changed to the vignette color, depending on the vignette shape.

Size

The radius of the vignette. At 0, the vignette fits perfectly in the image. Negative values
decrease the size of the vignette towards the interior of the image. Positive values increase the
size of the vignette beyond the boundary of the image.

Feather
The feathering affects the softness of the vignette. When low, the vignette has a hard edge.
When high, the vignette is blurry and soft.

Distortion Amount
Affects the randomness of the vignette. When high, the vignette wanders from being a perfect
ellipse.

LIGHTING TAB

Lighting controls the appearance of the canvas texture and thick paint ridges. If you have a
strong canvas or paint style (like Impasto), the lighting effects will be more noticeable.

Direction

Controls the direction from which the light falls on the canvas. Click and drag within the lighting
control box to change the direction, or enter a value between 0 and 360 degrees.

Inclination

Controls the angle formed by the light and the page. Click and drag within the lighting control
box to change the inclination, or enter a value between 0 and 90 degrees.

Highlight Brightness
Controls the intensity of the shiny highlights appearing on areas facing the light.

Highlight Size
Controls the size of the shiny highlights on areas facing the light; higher values yield larger
highlights.

Highlight Color
Choose any color for the shiny highlights.



Color Pencil

|

BASIC TAB

Create Output In New Layer Above Current
This control is described in the Control Tabs chapter earlier.

Stroke Direction

The average direction of the lines. The Stroke Directional Bend slider can make the lines
wander away from this direction.

Stroke Directional Bend

The amount the strokes differ from the fixed stroke direction. When high, the strokes follow the
image features and look more abstract. When low, the strokes all follow a fixed direction.

Pencil Width

Controls the width of the lines and the size of the features in the rendering. When low, small
edge details are revealed. When high, the image overall becomes softer.

Photorealism Amount

Increases the detail for the entire image. Higher values create a more photorealistic look. Note,
the image sharpness will be influenced by the Pencil Width slider. When the Pencil Width is
large, the result will be softer than when the Pencil Width is small.

Overall Pencil Coverage

This controls the number of pencil strokes. Low values produce a light picture while higher
values produce a darker more detailed picture.

Pencil Pressure
Higher pressure leaves more pigment on the paper, producing a darker and denser result.

Random Seed
Controls the random placement of strokes. Click it until you get a result you like.



COLORS TAB

Saturation

Saturation controls the intensity of all colors in the photo. High saturation yields a more vibrant
image, while lower yields a more muted image.

Contrast

Increasing this slider brightens highlights and darkens shadows. Increasing contrast will usually
make the image more dramatic at the expense of losing detail in highlights and shadows.

Brightness
Brightness lightens or darkens the entire image.

Color Temperature (Cool/Warm)

Positive values warm the image, which shifts colors toward yellow. Negative values cool the
image, which shifts colors toward cyan.

Number of Pencil Colors

This is the number of distinct colors used for the palette. When set low, the limited color range
will create a more abstract look. If you would like a wider range of colors, set the value higher.

CANVAS TAB
For more information, see the Ganvas section in the Gontrol Tabs chapter.

LIGHTING TAB
For more information, see the Lighting section in the Control Tabs chapter.




BASIC TAB

Create Output In New Layer Above Current
This control is described in the Control Tabs chapter earlier.

Comics Mode

Color Comics

Color Comics mode divides the image into large regions of uniform color and fills these with
half-tone patterns. In addition, the dark regions are drawn with high contrast and a shading
pattern at the edges.

Black and White Comics
Black and White Comics mode creates a monochrome image. This mode simply draws the dark
regions of Color Comics mode without the uniform color regions.

Shading Pattern
This lets you choose the pattern that fills the dark regions.

Feature Size
This controls the size of the features in the image as well as the half-tone and shading patterns.

Edge Strength
This increases the number and thickness of dark lines along important edges.

Halftoning Amount
This controls the prominence of half-toning dots.

Shading Amount

Controls the range of dark tones affected by shading. Higher values cover more areas with
shading.



Shading Scale

Controls the size of the shading pattern used in the shadows of the image. Low values create a
more closely spaced pattern while high values result in a larger, wider pattern.

Posterization
This controls the amount of color reduction. Low values result in large areas of uniform color.

Random Seed
Controls the random elements of this filter. Click it until you get a result you like.

COLORS TAB

Saturation

Saturation controls the intensity of all colors in the photo. High saturation yields a more vibrant
image, while lower yields a more muted image.

Contrast

Increasing this slider brightens highlights and darkens shadows. Increasing contrast will usually
make the image more dramatic at the expense of losing detail in highlights and shadows.

Brightness
Brightness lightens or darkens the entire image.

CANVAS TAB
For more information, see the Canvas section in the Control Tabs chapter.

LIGHTING TAB
For more information, see the Lighting section in the Control Tabs chapter.




Iimpasto

BASIC TAB

Create Output In New Layer Above Current
This control is described in the Control Tabs chapter earlier.

Brush Style
The brush style affects the pattern of thick paint ridges left by each stroke.

Brush Size

Controls the width of the brush and the size of the features in the rendering. When low, smaller
edge details are revealed. When high, the overall image becomes softer.

Photorealism Amount

Increases the detail for the entire image. Higher values create a more photorealistic look. Note,
the image sharpness will be influenced by the Brush Size slider. When the Brush Size is large,
the result will be softer than when the Brush Size is smalll.

Stroke Curvature

Higher values allow strokes to follow edges around corners. Lower values yield mostly straight
strokes.

Paint Stroke Length
Low values turn all the brush strokes into dots. High values yield longer strokes.

Paint Coverage

The amount of paint applied to the canvas. When high, the canvas is covered with thick,
textured paint. When low, less paint is applied and the result is softer and more recognizable.

Random Seed
Controls the random placement of strokes. Click it until you get a result you like.



COLORS TAB

Saturation

Saturation controls the intensity of all colors in the photo. High saturation yields a more vibrant
image, while lower yields a more muted image.

Contrast

Increasing this slider brightens highlights and darkens shadows. Increasing contrast will usually
make the image more dramatic at the expense of losing detail in highlights and shadows.

Brightness
Brightness lightens or darkens the entire image.

Color Temperature (Cool/Warm)

Positive values warm the image, which shifts colors toward yellow. Negative values cool the
image, which shifts colors toward cyan.

Random Color Variation

This controls how much the stroke color varies from the true color of the original image. Larger
values give more abstract, colorful results.

CANVAS TAB
For more information, see the Ganvas section in the Gontrol Tabs chapter.

LIGHTING TAB
For more information, see the Lighting section in the Control Tabs chapter.




Oil Paint

BASIC TAB

Create Output In New Layer Above Current
This control is described in the Control Tabs chapter earlier.

Brush Style
The brush style affects the pattern of thick paint ridges left by each stroke.

Brush Size

Controls the width of the brush and the size of the features in the rendering. When low, smaller
edge details are revealed. When high, the overall image becomes softer.

Photorealism Amount

Increases the detail for the entire image. Higher values create a more photorealistic look. Note,
the image sharpness will be influenced by the Brush Size slider. When the Brush Size is large,
the result will be softer than when the Brush Size is smalll.

Paint Thickness

The amount of paint applied to the canvas. Higher values give sharper results. Lower values are
softer and allow the canvas to show through.

Paint Stroke Length

The length of the paint stroke. Low values turn all the brush strokes into dots. High values yield
longer strokes.

Random Seed
Controls the random placement of strokes. Click it until you get a result you like.

COLORS TAB

Saturation
Saturation controls the intensity of all colors in the photo. High saturation yields a more vibrant



image, while lower yields a more muted image.

Contrast

Increasing this slider brightens highlights and darkens shadows. Increasing contrast will usually
make the image more dramatic at the expense of losing detail in highlights and shadows.

Brightness
Brightness lightens or darkens the entire image.

Color Temperature (Cool/Warm)

Positive values warm the image, which shifts colors toward yellow. Negative values cool the
image, which shifts colors toward cyan.

Random Color Variation

This controls how much the stroke color varies from the true color of the original image. Larger
values give more abstract, colorful results.

CANVAS TAB
For more information, see the Ganvas section in the Gontrol Tabs chapter.

LIGHTING TAB
For more information, see the Lighting section in the Gontrol Tabs chapter.




BASIC TAB

Create Output In New Layer Above Current
This control is described in the Control Tabs chapter earlier.

Pastel Type

Select the material of the pastel stick. A hard pastel is usually rough with less coverage while a
soft pastel is a bit smoother. An oil pastel resembles an oil painting.

Brush Size

Controls the width of the pastel stick and the size of the features in the rendering. When low,
smaller edge details are revealed. When high, the overall image becomes softer.

Photorealism Amount

Increases the detail for the entire image. Higher values create a more photorealistic look. Note,
the image sharpness will be influenced by the Brush Size slider. When the Brush Size is large,
the result will be softer than when the Brush Size is smalll.

Coverage

The amount of pastel applied to the canvas. Low coverage allows more of the canvas to show
through.

Paint Stroke Length

The length of the paint stroke. Low values turn all the brush strokes into dots. High values yield
longer strokes.

Random Seed
Controls the random placement of strokes. Click it until you get a result you like.



COLORS TAB

Saturation

Saturation controls the intensity of all colors in the photo. High saturation yields a more vibrant
image, while lower yields a more muted image.

Contrast

Increasing this slider brightens highlights and darkens shadows. Increasing contrast will usually
make the image more dramatic at the expense of losing detail in highlights and shadows.

Brightness
Brightness lightens or darkens the entire image.

Color Temperature (Cool/Warm)

Positive values warm the image, which shifts colors toward yellow. Negative values cool the
image, which shifts colors toward cyan.

Random Color Variation

This controls how much the stroke color varies from the true color of the original image. Larger
values give more abstract, colorful results.

CANVAS TAB
For more information, see the Ganvas section in the Gontrol Tabs chapter.

LIGHTING TAB
For more information, see the Lighting section in the Control Tabs chapter.




Pen and Ink

oy

BASIC TAB

Create Output In New Layer Above Current
This control is described in the Control Tabs chapter earlier.

Stroke Direction
The direction of the cross hatching lines.

Shading Pattern
The density of the cross hatching pattern used in the shadows (sparse or dense).

Pen Width
Controls the width of the lines and the size of the features in the rendering.

Tone Amount

The brightness threshold for the cross hatching pattern. When low, only the darkest shadows
will be drawn.

Edge Detail Amount
The amount of darkening associated with the edge features.

Pen Stroke Length
The average length of the pen strokes.

Random Seed
Controls the random placement of strokes. Click it until you get a result you like.

TONE TAB
The tone tab lets you adjust the conversion of your color image to grayscale.

Contrast
Increasing this slider brightens highlights and darkens shadows. Increasing contrast will usually



make the image more dramatic at the expense of losing detail in highlights and shadows.

Brightness
Brightness lightens or darkens the entire image.

Automatic Color Conversion

The color image is converted to grayscale before it is converted to strokes. When this checkbox
is enabled, the conversion automatically mimics the human eye’s response to red, green, and
blue light. If it is cleared, you can manually specify how the conversion interprets each color
channel.

Red Channel Strength (%)
Amount the red channel affects the result. Higher values make red areas lighter.

Green Channel Strength (%)
Amount the green channel affects the result. Higher values make green areas lighter.

Blue Channel Strength (%)
Amount the blue channel affects the result. Higher values make blue areas lighter.

CANVAS TAB
For more information, see the Canvas section in the Gontrol Tabs chapter.

LIGHTING TAB
For more information, see the Lighting section in the Gontrol Tabs chapter.




Pencil Sketch

BASIC TAB

Create Output In New Layer Above Current
This control is described in the Control Tabs chapter earlier.

Stroke Direction

The average direction of the lines. The Stroke Directional Bend slider can make the lines
wander away from this direction.

Stroke Directional Bend

The amount the strokes differ from the fixed stroke direction. When high, the strokes follow the
image features and look more abstract. When low, the strokes all follow a fixed direction.

Pencil Type
The type of pencil media used.

Pencil Width
Controls the width of the lines and the size of the features in the rendering.

Photorealism Amount

Increases the detail for the entire image. Higher values create a more photorealistic look. Note,
the image sharpness will be influenced by the Pencil Width slider. When the Pencil Width is
large, the result will be softer than when the Pencil Width is small.

Overall Pencil Coverage

The density and threshold for the pencil strokes. When set low, more of the paper will show
through. When set high, the pencil covers more of the canvas.

Pencil Pressure
The opacity of the pencil strokes.



Pencil Stroke Length
The average length of the pencil strokes.

Random Seed
Controls the random placement of strokes. Click it until you get a result you like.

TONE TAB
The tone tab lets you adjust the conversion of your color image to grayscale.

Contrast

Increasing this slider brightens highlights and darkens shadows. Increasing contrast will usually
make the image more dramatic at the expense of losing detail in highlights and shadows.

Brightness
Brightness lightens or darkens the entire image.

Automatic Color Conversion

The color image is converted to grayscale before it is converted to strokes. When this checkbox
is enabled, the conversion automatically mimics the human eye’s response to red, green, and
blue light. If it is cleared, you can manually specify how the conversion interprets each color
channel.

Red Channel Strength (%)
Amount the red channel affects the result. Higher values make red areas lighter.

Green Channel Strength (%)
Amount the green channel affects the result. Higher values make green areas lighter.

Blue Channel Strength (%)
Amount the blue channel affects the result. Higher values make blue areas lighter.

CANVAS TAB
For more information, see the Canvas section in the Control Tabs chapter.

LIGHTING TAB
For more information, see the Lighting section in the Control Tabs chapter.



BASIC TAB

Create Output In New Layer Above Current
This control is described in the Control Tabs chapter earlier.

Brush Size

Controls the width of the brush and the size of the features in the rendering. When low, smaller
edge details are revealed. When high, the overall image becomes softer.

Photorealism Amount

Increases the detail for the entire image. Higher values create a more photorealistic look. Note,
the image sharpness will be influenced by the Brush Size slider. When the Brush Size is large,
the result will be softer than when the Brush Size is small.

Paint Thickness

The amount of paint applied to the canvas. Higher values give sharper results. Lower values are
softer and allow the canvas to show through.

Paint Coverage

The amount of paint applied to the canvas surface. When low, the paint strokes are spaced
further apart and more canvas will show through.

Paint Stroke Length

The length of the paint stroke. Low values turn all the brush strokes into dots. High values yield
longer strokes.

Random Seed
Controls the random placement of strokes. Click it until you get a result you like.



COLORS TAB

Saturation

Saturation controls the intensity of all colors in the photo. High saturation yields a more vibrant
image, while lower yields a more muted image.

Contrast

Increasing this slider brightens highlights and darkens shadows. Increasing contrast will usually
make the image more dramatic at the expense of losing detail in highlights and shadows.

Brightness
Brightness lightens or darkens the entire image.

Color Temperature (Cool/Warm)

Positive values warm the image, which shifts colors toward yellow. Negative values cool the
image, which shifts colors toward cyan.

Random Color Variation

This controls how much the stroke color varies from the true color of the original image. Larger
values give more abstract, colorful results.

CANVAS TAB
For more information, see the Ganvas section in the Gontrol Tabs chapter.

LIGHTING TAB
For more information, see the Lighting section in the Control Tabs chapter.




BASIC TAB

Create Output In New Layer Above Current
This control is described in the Control Tabs chapter earlier.

Stylize Mode

Colored lllustration
The image is reduced to large areas of uniform color. Then dark lines are drawn along strong
edges.

Line Art
Only the edge lines of the Colored lllustration mode are drawn. The rest of the image is filled
with the canvas color.

Feature Size

Controls the size and spacing of the edge lines and the size of features retained from the
original photo.

Number of Lines
Higher values draw more edge lines.

Shadow Threshold
Higher values increase the area rendered as dark shadows.

Posterization
The amount of color reduction. Lower values result in fewer solid filled areas.

PEN TAB

Pen Color
Color of the edge lines.



Pen Style
The pen style controls how strokes vary in thickness along their length.

Pen Style Effect

Controls how much the pen style affects the strokes. Turning this down makes the strokes more
uniform in thickness.

Pen Width
Larger values make thicker edge strokes.

Line Flexibility

Higher values allow strokes to hug edges. Lower values make strokes straighter and less true to
the edges in the original image.

Random Seed
Controls the random elements of this filter. Click it until you get a result you like.

COLORS TAB

Saturation

Saturation controls the intensity of all colors in the photo. High saturation yields a more vibrant
image, while lower yields a more muted image.

Contrast

Increasing this slider brightens highlights and darkens shadows. Increasing contrast will usually
make the image more dramatic at the expense of losing detail in highlights and shadows.

Brightness
Brightness lightens or darkens the entire image.

CANVAS TAB
For more information, see the Ganvas section in the Gontrol Tabs chapter.

LIGHTING TAB
For more information, see the Lighting section in the Control Tabs chapter.



Watercolor

BASIC TAB

Create Output In New Layer Above Current
This control is described in the Control Tabs chapter earlier.

Brush Size

Controls the width of the brush and the size of the features in the rendering. When low, smaller
edge details are revealed. When high, the overall image becomes softer.

Photorealism Amount

Increases the detail for the entire image. Higher values create a more photorealistic look. Note,
the image sharpness will be influenced by the Brush Width slider. When the Brush Width is
large, the result will be softer than when the Brush Width is small.

Paint Coverage

The amount of paint applied to the canvas. Lower values are softer and allow more of the
canvas to show through.

Paint Coverage

The amount of paint applied to the canvas surface. When low, the paint strokes are spaced
further apart and more canvas will show through.

Paint Stroke Length

The length of the paint stroke. Low values turn all the brush strokes into dots. High values yield
longer strokes.

Random Seed
Controls the random placement of strokes. Click it until you get a result you like.



COLORS TAB

Saturation

Saturation controls the intensity of all colors in the photo. High saturation yields a more vibrant
image, while lower yields a more muted image.

Contrast

Increasing this slider brightens highlights and darkens shadows. Increasing contrast will usually
make the image more dramatic at the expense of losing detail in highlights and shadows.

Brightness
Brightness lightens or darkens the entire image.

Color Temperature (Cool/Warm)

Positive values warm the image, which shifts colors toward yellow. Negative values cool the
image, which shifts colors toward cyan.

Random Color Variation

This controls how much the stroke color varies from the true color of the original image. Larger
values give more abstract, colorful results.

CANVAS TAB
For more information, see the Ganvas section in the Gontrol Tabs chapter.

LIGHTING TAB
For more information, see the Lighting section in the Control Tabs chapter.
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